
October’s meeting no doubt left LIMac mem-
bers craving caffeine, amphetamines – or 
anything – in an effort to keep up with Dave 
Marra, a senior systems engineer of Apple 
Computer, who squeezed tons of information 
on Mac OS 10.2 (Jaguar) into a little over an 
hour’s-worth of presentation time.

Dave explained and demonstrated several 
of the new Mac OS’s key features:
| Rendezvous Apple’s home networking tech-
nology that enables users to link computers 
and devices without any configuration.
| iChat Apple’s new AIM-compatible, instant 
messaging application.
| Quartz Extreme accelerated graphics perfor-
mance that delivers graphics three times faster 
for seamless 2D, 3D and QuickTime content.
| Inkwell advanced handwriting recognition 
that is fully integrated into the text system.
| Jaguar also offers improvements in font man-
agement, file sharing, and protected memory, 
all on a rock-solid UNIX-based foundation for 
better stability.

You can learn more about Dave and Jaguar 
at www.marrathon.com; click on Presentations 
to get more info on Mac OS X 
in general as well as Dave’s
show schedule. 0 –Ela Schwartz

You won’t want to miss the November general 
meeting when LIMac’s special guest will be 
Bob “Dr. Mac” LeVitus. Bob describes himself 
as, “a writer, raconteur, and Macintosh con-
sultant” who “mostly fool[s] around with a 
variety of Mac OS computers and software.” He 
has written for almost every publication which 
has the word Mac in its title; has authored 37 
computer books including Dr. Macintosh, Mac 
OS X for Dummies and The Little iTunes Book; 
writes a weekly column called appearing in the 
HOUSTON CHRONICLE, and is the editor of 
the Mac OS X Frequently Asked Questions Web 
site, a “technical news and support [site] for 
Mac OS X.”

You can find out more about Bob before 
his visit on his Web site: www.BobLeVitus.com 
and Mac OS X users should visit: Mac OS X 
Frequently Asked Questions at: www.osxfaq.com 
for valuable tips, news and information.

And as usual, there will also be Bradley’s 
Q&A, the raffle and shmoozing. 0

–Rick Matteson 
Friday, November 8th, 7 p.m. 
Building 300 (Anna Rubin Hall) 
The New York Institute of Technology 
Old Westbury. 0

LIMac

Pay Your 2002 Dues: 
Send your $36 check to: 
Long Island Macintosh Users Group 
Post Office Box 2048
Seaford, New York 11783-2048 
or bring it to the next meeting! 0

The slate for LIMac officers in 2003: 
President: Bill Medlow
Vice President: Al Choy
Treasurer: Max Rechtman
Secretary: Joan Bernhardt
Membership Chairman: Donald Hennessy 0

NEWSLETTER OF THE LONG ISLAND MACINTOSH USERS GROUP

The Internet SIG: Held at the Bethpage Public Library, (516) 931-3907, 
on the third Monday of each month at 8 p.m. 
Multimedia SIG: Will be held on the third Monday of the month at 7:30 
P.M. in Bernie Flicker’s offices: ABC Industries, 100 Cleveland Avenue, 
Freeport, (516) 867- 8400, ext. 325.
SIGs immediately before or after the general meeting: 
Beginners SIG: Because our featured guest this month is Bob LeVitus 
there will be an abbreviated Beginner’s SIG meeting beginning early (at 
7:00 p.m.) consisting of  a brief Q&A and announcement session then 
move on to the main room to hear LeVitus. 
Immediate Users SIG: All about battery backup devices, also known as 
uninterruptable power systems.
DTP/Photoshop SIG: Come with a positive attitude.
Photography SIG: 6:30 to 7:30 under the TV in the back of the room. 

| LIMac meetings, unless other-
wise noted, are held in Building 
300 (Anna Rubin Hall) at the 
New York Institute of Technology 
on Northern Boulevard in Old 
Westbury, L.I.
| In bad weather, call (516) 
686-7789.
| The next LIMac board meeting 
will be at the Plainedge Library, 
(516) 735-4133, on Wednesday, 
November 13th, at 8 p.m.
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Maintaining the 
position of copied 
objects in InDesign :
InDesign works on 
a center point of 
origin, so if you want 
to copy an object on 
one page and paste 
it in the exact same 
spot on another page, 
forget the Paste 
command – you need 
the Paste In Place 
command. 

To paste a copied 
graphic from one 
page onto the same 
spot on another page, 
select the object 
you want to copy 
and then choose 
Edit > Copy, or press 
Command-C. Go to 
the page on which 
you want to paste 
the object and then 
choose Edit > Paste 
In Place, or press 
Command-Option-
Shift-V. Your copied 
object will be posi-
tioned on the new 
page at the exact 
same coordinates as 
the original, rather 
than in the center of 
the page. 

As of this writing, I.D.G. intends to move 
MacWorld Expo back to Boston in 2004 and I 
get the impression that Apple isn’t happy.

It is my understanding that five years ago 
Apple wanted the move to New York City 
for many sound socio-economic reasons, 
including the ability to have the Expo in one 
venue. (The Boston show was in two build-
ings separated by a 20-minute bus ride.) Don’t 
get me wrong; Boston is a great city to visit. 
I always brought my family to the Expo and 
always had issues with the jacked-up hotel and 
parking prices.

I agree with Apple’s thinking and let’s face 
it, it’s very convenient for us. For I.D.G. this 
may be an opportunity they can’t pass up. For 
LIMac, I hope to see us at Macworld Expo in 
N.Y.C. next July, showing everyone (especially 
those Mac users on Long Island who haven’t 
heard of us yet) just who we are: the best Mac 
User Group around with the best newsletter 
and Web site. We are just like Apple and the 
Big Apple – simply, the best. 0

Attention LIMac Members:
Please note the new link in the head of the 
LIMac Web site for classified ads. Besides the 
free ads offered to members in the FORUM, we 
are offering with no time limit, an ad on our 
Web site. 

Gain greater exposure and timeliness. 
You can advertise in four main categories: 

Help Wanted, Seeks Employment, For Sale and 
Wanted to Buy. 

Sale items are limited to five items per ad. 
If you have pictures of the items you wish to 
sell, you can submit them. 

See the Web site for more details. 0

Subscription Offer for LIMac Members.
MACHOME is offering LIMac members a 50% 
discount* off of the regular subscription prices. 
For only $14.99, new subscribers can receive 12 
issues of MACHOME – only $1.25 an issue!

Call 1-800-800-6542 (mention code SMUG 
when calling) or subscribe online at: https:// 
www.machome.com/subscribe/mugoffer.

*Offer good on new subscriptions only. 
Offer expires February 28, 2003. 
Offer valid in the US.
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President’s Message

Bill Medlow
President
ArchBill@aol.com

Bradley’s Tech Session
| I clicked on a AppleWorks file and I get a 
message that it can’t be opened because of 
an Error-37. What does that mean?
This indicates a bad file name. This could 
happen if a Mac OS 9 machine tries to access a 
file on a Mac OS X machine. Mac OS X allows 
longer file names than Mac OS 9 understands. 
The file clicked on may not be the one at fault 
directly. It may cause some other file to be 
opened that has the problem. It can also mean 
it’s time to run Norton Disk Doctor.
| I have another file in another folder that 
when I try to click on it, the Mac says it 
can’t be opened because it cannot be found. 
I can’t trash it either. It’s on a floppy and 
it works fine on another Mac. I’m using an 
Imation floppy drive.
More evidence you have directory damage 
and should run Disk Doctor. This type of 
problem occurs more often when Macs use a 
Windows server. Make sure you have the latest 
AppleShare client appropriate for your ver-
sion of the Mac OS. A related problem occurs 
when you’ve updated programs and click on 
a old file. Rebuilding the Desktop will help in 
these circumstances. It’s always a good idea to 
rebuild the Desktop after installing programs, 
but it can fix rare problems after just a minor 
update. You can also run Disk Doctor on a 
floppy. Be aware that floppies wear out with 
use and so do floppy drives. You can also get 
errors reading disk because of dirt in the drive 
or on the heads. Use only a 3M brand floppy 
drive cleaning diskette – if you can still find 
them. The Imation drives only work with 
the high density floppy disks, so it’s heads are 
weaker than the older FDHD drives Apple used 
internally that also read and write the older 
800K double-sided/double-density disks.
| I need a recommendation for a FireWire 
CD recorder.
I prefer the Yamaha brand. They have the 
CRW3200FXZ 24X recorder ($193 after $50 
rebate) and they are now shipping the 44X 
CRW-F1ZSX with FireWire and USB 2.0 con-
nections. For full details see www.yamaha.com/
yec/multimedia/customer/features/feat_prod-
sCRWF1_1.html. About $263 at buy.com. 
Comes with Toast Lite, but you may want to 
upgrade to Roxio Toast 5.2 Titanium for full 
flexibility. The new drive is the only one to 

 TIP!

(Continued from last month.)

| Application Switcher Menu 
Remember the handy drop-down 
menu which listed your loaded 

applications on the upper right? It’s baaack! 
ASM is absolutely free from Frank Vercreusse, 
a young programmer living in Leipzig, Germany. 
Although it is an add-on “menu extra” in OS X 
terminology, it’s also absolutely trouble-free 
to install and use. ASM does just what you’d 

expect in OS 9 : run your mouse to the upper 
right screen and down drops a list of all your 
open applications. Select from any in the list to 
switch from one to another just like in the old 
days. (You’ll also feel like donating a little some-
thing to keep this talented developer working. 
He says a more wide-ranging menu utility is 
forthcoming. Here’s hoping it removes the new 

“Application menu” from its annoying bold-faced 
location in the menu bar, which interrupts the 

classic Apple-File-Edit pattern which has been 
consistent for over a decade and assists in easy 
learning of new Mac application. Because of 
this added menu, you won’t find Quit under the 
File menu any more.  ASM has some wonderful 
and very thoughtful custom options worthy 
of OS X. 
http://asm.vercruesse.de/ 
| X-Assist  Australian Peter Li’s competing 
application switcher menu, also freeware, is X-

Assist. It’s a bit richer in features, with support 
for unlimited levels of submenus (the usual is 
five), part of this utility’s ability to emulate the 
old Apple menu. Some users may find X-assist 
a really good solution if they desire to leave 
the OS X Apple Menu as they find it. I have not 
heard from many who are willing to do so, but  
this utility seems very polite in mixed company. 
http://members.ozemail.com.au/~pli /x-assist.
Classic Finder Enhancements

Bradley Dichter
bdichter@cdr.net

 TIP!
Saving pages From 
Explorer :
When you find a 
Web page of interest 
while you’re surfing, 
chances are you 
bookmark it so you 
can view it again at a 
later date. Normally, 
this is fine, unless 
of course it isn’t the 
site, but the partic-
ular page that you’re 
interested in. 

For example, let’s 
say you find a killer 
recipe for seviche 
and want to save it. 
If you use a book-
mark, that recipe 
might be moved to 
another page or even 
removed from the 
site before you view 
it again. In that case, 
the bookmark might 
still work, but it won’t 
display the recipe. 

Fortunately, when 
using Microsoft 
Internet Explorer, 
there’s a very elegant 
solution — save the 
file to the Scrapbook. 
This effectively 
saves a snapshot of 
that page for you to 
review whenever you 
like — even when 
you’re off line.

http://asm.vercruesse.de/
http://members.ozemail.com.au/~pli /x-assist
http://www2.limac.org/limac/ads.html
https://www.machome.com/subscribe/mugoffer
https://www.machome.com/subscribe/mugoffer
http://www.yamaha.com/yec/multimedia/customer/features/feat_prodsCRWF1_1.html
http://www.yamaha.com/yec/multimedia/customer/features/feat_prodsCRWF1_1.html
http://www.yamaha.com/yec/multimedia/customer/features/feat_prodsCRWF1_1.html
http://www.buy.com/retail/product.asp?sku=10328305&hdwt=0&loc=101


support the disc tattoo labeling function on 
the unused portion of the disc. For the rest of 
you with old Macs, they also have the CRW-
F1ZSX as an external SCSI model, but since 
44X is beyond the 5MB/sec transfer rate of 
the old external SCSI port, you can’t take full 
advantage of the unit without a fast SCSI card. 
I’d recommend then, their CRW3200SXZ. The 
external SCSI unit uses a high density 50-pin 
connector and does not come with a SCSI 
cable. Yamaha recommends their brand blank 
discs for their drives. You can buy them at 
www.yamahashoponline.com/interface/home_
cat.asp?CatID=4&CatName=Blank+Media. 
They have special blue Azo dye blank discs 
optimized for the disc tattoo (DiscT@2™) that 
offers high contrast, but some drives may have 
a problem reading them. Their 48X certified 
“Professional Grade CD-R Media” are available 
now in the 50 pack on spindle for $39.99 with 
free shipping. Buy.com has them for $29.75
| I use ATM Deluxe in Mac OS 9.2.2 and I 
had a folder with my font collection. Now 
that I’m spending most of my time in Mac 
OS 10.2 , I just got Extensis Suitcase 10. Do I 
have to transfer everything over?
You can use Suitcase 10 in Mac OS 9 as 
well as 10. See www.extensis.com/suitcase/
18g.html#atm. There’s a link to a free utility 
that “can import all of the font sets that you 
have created in ATM Deluxe directly into 
Suitcase 10. If you are upgrading to Suitcase 
from ATM Deluxe, this free utility will save you 
the time of having to recreate all of your font 
sets. Make quite sure you have version 10.1.3. 
(There’s a free updater from 10.1.2.) Hopefully, 
your Suitcase sets can be saved from 9 to 10.
| The AppleWorks 6 manual says nothing 
about how to select records that have a field 
that contains a certain combination of 
letters. The Find function only selects one 
record at time.
Go to the Layout menu and select Find (Shift-
Command-F) and just type in the text you seek 
in that particular field. You can use operators 
like > or >= in both text and numeric fields. 
Then press the return key or click the Find 
button on the left to hide all the records that 
do not have the text you want. If you seek 
more than one text string, then after you 
type the first sought after text string then 

go the Edit menu and select New Request 
(Command-R) to enter a second criteria set 
of search parameters. It’s not entirely obvious 
that this is possible, but it is explained in the 
online help under the caption “Performing a 
multiple find request” Remember to go to the 
Organize menu and select Show All Records 
(Shift-Command-A) when finished. The other 
way to do a find of this type is this: You need 
to go to the Organize menu and select Match 
Records (Command-M). I suggest limiting your 
list of functions to Text from the pop-up and 
then clicking on Find (find text, in text, start 
offset) The find text argument is highlighted. 
Type the letter or text string in quotes. Then 
highlight the in text argument and then click 
on the field you wish to search in, and then for 
the start offset argument, you probably want to 
just type a zero. Then click OK and AppleWorks 
will highlight the records with the text you 
seek. One last suggestion: if you get frustrated 
by AppleWorks, buy FileMaker Pro. It can con-
vert AppleWorks databases.
| Can you suggest a Firewire hard drive to 
backup my iBook?
I’d suggest Other World Computing’s Mercury 
On-The-Go 20GB 4200rpm compact model. 
They have higher capacity models (up to 
60GB) that have more space than your iBook’s 
internal hard drive. Basically it’s a little 2.5 
inch format hard drive similar to the one in 
your laptop. They also have models with faster 
mechanisms, which are really not much of an 
issue for backup. It can be FireWire bus pow-
ered for portable use, but it also comes with an 
AC adapter when you’re home. It even comes 
with a nice little carrying case if you want it. 0

More of Bradley’s Tech Session 3
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| WindowShade X That’s right! This restores 
the delightful ability to zip a work window not 
into the Dock, but into itself right up into its 
title bar to clear screen space, to see anything 
behind it. Were you missing this? Relax, it’s 
back. Here you can also set a double-click to 
make the window transparent. Photoshop users 
live by it. There’s also an option to remove the 
drop shadows on windows cast by OS X. Some 
users report a slowdown after this shareware 

utility is installed, but mine on a G4 Dual-800 
tower is very well-behaved. www.unsanity.com.
| Workstrip X  This is a handsome Control 
Strip replacement from a British company, 
and, as with many re-enhanced utilities here, 
adds new features, but the company currently 
has no plans to foment outside Workstrip
modules which third party developers might 
add through a simple software development 
kit, so I worry about its future. Adds useful file 

preview capabilities and easy-to-find system 
control over monitor resolution, sound, etc. 
Mouse responsiveness seemed a little clunky. 
www.softchaos.com.
| Coela If you’ve noodled about in OS X ’s 
Columns view window you know it can behave 
unexpectedly. As you scroll to the right from 
the desktop view of available disks, revealing 
contents as you “drill down,” you can easily lose 
your place. In addition there’s no way to color-

label files and sort disk or folder contents. Enter 
Coela, which adds spring-loaded file finding 
features and customizes view windows. It adds 
back file color labeling, to assist in finding stuff.. 
If you like Windows File Manager – like columns 
surfing, Coela makes it fun. Its programmer is 
Japanese but the application is totally English 
and has many fans here. It’s also well-behaved. 
www.bekkoame.ne.jp/~iimori/sw/Coela.html. 0

–Loren S. Miller (More later. –Ed)

OS X Partitioning 
schemes:
How you partition 
your drive will 
depend on how you 
plan on using Mac 
OS X. If you still rely 
quite heavily on OS 
9 for productivity, 
but you want to 
explore OS X, I would 
recommend that 
you partition your 
drive. If you plan on 
migrating entirely 
to OS X, except for 
the occasional boot 
into OS 9 to burn 
CDs or watch a DVD, 
you really don’t need 
to partition your 
drive. Finally, if you 
have less than 512 
MB of RAM and are 
unwilling to make 
the (very worthwhile) 
upgrade, you may 
want to consider 
creating a partition 
for swapfiles or using 
a separate disk 
entirely. 

A separate hard 
drive can be very 
valuable as a swap 
partition because 
you can still be 
reading/writing 
from your primary 
disk while the OS 
performs swap 
functions. A very 
fast, separate disk 
could also be quite 
valuable as scratch 
space for Photoshop, 
especially in a high-
productivity environ-
ment. 

–Mike Bombich

47% of prepress 
users repurpose 
PDFs for other 
media:
Results from the  
Seybold trade show’s 
year-long survey were 
released. While it’s 
encouraging to see 
PDF’s widespread 
adoption across 
publishing platforms, 
power users still 
aren’t yet working in 
an Acrobat utopia. 
Highlights from the 
survey include these 
figures:
| PDF users rank 
“fewer cross-plat-
form issues” as 
the biggest benefit 
of PDF, and the 
“difficulty to edit PDF 
files” as the format’s 
leading negative.
| 47% of the PDF 
generators reuse 
PDF files for other 
print jobs, 61% for 
the Web and 39% for 
CD-ROM.
| In 52% of the PDF 
generators’ print 
jobs, PDF is used for 
soft proofing.
| A majority of 
the PDF receivers 
report that they 
“sometimes” find 
errors that require 
corrections in either 
native files or in PDF, 
but close to a third 
report that this is 
“often” the case.  0

Sore Eyes continued from Page 4

 TIP! ‘‘’’ QUOTES
word in the password field.
If you’re using Mac OS 9.x, choose Chooser 

from the Apple Menu; then click AppleShare. 
Click the Server IP Address button; type 
idisk.mac.com in the Server Address field; then 
click Connect. Type the other user’s member 
name and the user’s Public folder password; 
then click Connect. If the user doesn’t have 
a Public folder password, type public in the 
Password field. Select the user’s iDisk and click 
OK. 0
NOVEMBER 2002
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Your 2002 dues are $36. 
Bring your check to the next 
meeting or mail it to: 
Long Island Mac Users Group 
P.O. Box 2048 
Seaford, NY.11783-2048 

BEST IN SHOW
USER GROUP OVERALL

LONG ISLAND 
MAC USERS GROUP

Sore Eyes4

Helen and
Sheldon Gross
shel9
@ bellatlantic.net
Note: Sore Eyes site 
referrals are for your 
information only. 
Neither the Grosses 
nor LIMac endorse 
any of the sites or 
their products.

 TIP!
The rule about 
hairline rules in 
QuarkXPress :
While hairlines rules 
may look great 
onscreen and okay 
printed on a desktop 
printer, they prob-
ably won’t look so 
good when printed 
on an output device 
that prints over 300 
dpi. For this reason, 
it’s best to avoid 
using the Hairline 
option (defined 
as a zero width 
line) when drawing 
rules or frames in 
QuarkXPress. To 
ensure your rules 
print on any device, 
always define their 
line width no less 
than 0.25 points.

We want to thank the many members that have 
sent in their e-mail addresses so that we can 
keep you up to date on discounted hardware, 
software, books etc. that are available to User 
Group members only. If you have not yet sent 
in your e-mail address but would like to be 
notified of any specials please Send an e-mail 
to: aboutlimac@aol.com And on the subject 
line enter: LIMac this is…(your name).

The following special is available to 
qualifying K-12 teachers from now through 
December 31, 2002. Teachers can order a free 
for Teachers Kit which provides everything a 
teacher needs to learn and become comfortable 
with Mac OS X. This offer is limited to one 
Mac OS X v10.2 (Jaguar) for Teachers Kit per 
qualifying K-12 teacher. The kit includes the 
following items:
| Getting Started with Mac OS X Training CD 
filled with practice exercises, tips, and over 80 
QuickTime movies.
| Mac OS X v10.2 (Jaguar) Install CD Set
| Telephone support for 90 days
| Manual and License Agreement

To order your kit go to the following 
Web site: www.apple.com/education/
macosxforteachers/. You will need to fill out a 
brief one- minute application form. 0 

We’ve really done something this month. We 
are well into digital pictures. Shelly takes the 
photos. Then he downloads them to the Mac 
and beautifies them with Photoshop Elements.  
The pictures are then saved as .jpg files. A most 
important step in this process is to resize them 
since they come in from the camera as 16" by 
22." Then the pictures can be shown as a slide 
show or joined together in iMovie. At this 
point they can be e-mailed in either a folder 
or individually, depending upon the recipient’s 
computer’s capability.

I chose a different route. I’ve had a mem-
bership in iTools for some time now, and very 
reluctantly paid Apple to continue it for this 
year only at $49. I opened up my iDisk and 
loaded the folder of pictures to my Public 
folder. Instructions for viewing were down-
loaded from the Apple site. If anyone wants to 
see photos of Parents’ Weekend at UPenn, they 
are available. My iDisk name is rty13 and there 
is no password. (Type public when asked.)

Instructions follow. They work. Now, if 
I can figure out how to make them work for 
AOL users I’ll be way ahead.
| Connecting to someone’s Public folder using 
a Mac: You can open a .Mac member’s Public 
folder to see and copy files. To access some-
one’s Public folder, you need to know the per-
son’s member name and Public folder password 
(if the Public folder is password-protected).
| To open someone’s Public folder:
If you’re using Mac OS X version 10.1, choose 
Connect To Server from the Finder’s Go menu 
and type http://idisk.mac.com/membername/
Public (where membername is the person’s 
.Mac member name). If the Public folder is 
protected with a password, type public in the 
username field and type the Public folder pass
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You won’t want to miss the November 

general meeting when LIMac’s special 

guest will be Bob “Dr. Mac” LeVitus. 

Bob describes himself as, “a writer, 

raconteur, and Macintosh consultant” 

who “mostly fool[s] around with a 

variety of Mac OS computers and 

software.” He has written for almost 

every publication which has the word 

Mac in its title and has authored 37 

computer books.

Friday, November 8th at 7 p.m.

Anna Rubin Hall (Bldg. 300)

New York Institute of Technology

Old Westbury

DOCTOR      MAC

Max Rechtman
maxlimac
@ optonline.net
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